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Installing and running Total Commander  

by John Swale 
 
Total Commander is a highly respected dual-panel file manager that is easy to install, as outlined in 
this presentation by John Swale. 
 
Downloading Total Commander 

The best source for downloading Total Commander is the developer’s site at 
https://www.ghisler.com, with various versions available to accommodate different operating 
systems. 
 

 
Figure 21 – Total Commander website 

 
Versions 

 32-bit version only (Windows 95 up to Windows 11, runs on 32-bit and 64-bit machines.) 

 64-bit version only (Windows XP up to Windows 11, runs only on 64-bit machines!) 

 64-bit+32-bit combined download (Windows 95 up to Windows 11, 32-bit and 64-bit 
machines.)  

 PortableApps (installer for an existing installation on USB sticks) 
 

 
Figure 22 – Total Commander download webpage 
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Installation 

Most modern computers would require the 64-bit version and that was the one John downloaded 
and demonstrated. The downloaded file tcmd1103x64.exe was version 11.03 and is small by today’s 
standards at only 6.2MB. Running the installation file generally follows the default settings as 
shown in the 5 installation windows shown in Figure 23 below. Apart from a few necessary choices 
the installation process is very quick.  
 

 
Figure 23 – Total Commander installation  

 
Opening Total Commander 

Upon opening Total Commander, a Program Information / Shareware Registration window initially 
blocks the main file manager window. To remove this window, the user must press one of three 
numbered buttons to proceed, encouraging registration of the program. Each time you restart Total 
Commander, this barrier window reappears, requiring you to press one of the labelled buttons to 
proceed. This process is required until the program is registered. 

 

Figure 24 – Total Commander opening window 
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Figure 25 – Total Commander dual panel, Tree view 

 

Registration 

Total Commander is shareware and needs to be registered. A license can be purchased for one or 
multiple devices. As of the time of this presentation, the cost for a single license is A$75.65, with 
payment options including credit card or PayPal. John considers this good value, especially for 
power users like Peter, who rely heavily on Total Commander. 
 
 

 
 

Figure 26 – Total Commander registration 
 
Overall, Total Commander is an easy to install file manager offering wide-ranging configuration 
options, making it a valuable tool for both casual and power users. 
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Clover - Tabbed folders in Windows 10  

by Neil Muller  

 
Continuing with the theme of favourite Windows file managers, Neil Muller presented his preferred 
choice, Clover. 
 
Clover is based on Windows File Explorer and features tabbed folders and bookmark shortcuts. 
Neil finds he doesn't need a dual-panel file manager like Total Commander, but if necessary, 
running two instances of Clover can provide a similar dual-panel to Total Commander. 
 
Early File Managers  

To manage the data on Neil’s PC, a quick and easy to use file manager was the main criterion. In 
the DOS era it was Xtree & XtreeGold.  
 

 

Figure 27 – Xtree for DOS 
 
Windows File managers 

 With the release of Windows 3 and 3.1, Windows File Manager as it was then called, 
complimented Xtree as Neil’s go to file manager. When a dual panel file manager was 
needed, PowerDesk was the choice. PowerDesk looked like two instances of File Manager 
joined together. 

 

Figure 28 – File Manager Windows 3.1 
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 For Windows 95, 98, all the way through to XP, there were only minor tweaks to how 
Explorer looked and operated, until Windows 7 came along. 

Windows 7 

 Windows 7 introduced Libraries, a feature that grouped multiple actual folders on the disk 
to create a virtual container for a user’s content or project. By default, Libraries contain 
Windows system folders: Documents, Music, Pictures, and Videos. 

 Users can also create their own Library folders or virtual containers, which can include files 
and folders stored on the local computer. 

 Neil found Libraries extremely useful for quickly accessing files for certain activities and 
used them extensively. 

 Creating Libraries and adding folders to a Library was made easier with a freeware program 
called Librarian. While Libraries were very useful for certain tasks, most users ignored this 
new feature. 

 

 

Figure 29 – Windows 7 File Explorer 

 

 

Figure 30 – Windows 7 Librarian 
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Windows 10  

The arrival of Windows 10 brought two new and welcome features in Windows Explorer, which 
was later to be renamed File Explorer by MicroSoft. The first new feature was the Ribbon bar. 

 

 

Figure 31 – Windows 10 File Explorer featuring a Ribbon bar and Quick access. 
 
 

Ribbon bar 

 The File Explorer Ribbon bar resembles the ribbon first featured in Microsoft Office. It 
contains buttons for common tasks you can perform with your files and folders. The 
Navigation Panel on the left gives you access to Libraries as well as your storage devices. 

 The File Explorer Ribbon bar contains the File menu along with three tabs labelled: 

o Home: Provides access to the main file management commands.  

o Share: Offers options for sharing a selected item with others, including emailing, printing 
or faxing an item, burning it to a disk, and adding some security options.  

o View: Allows you choose between showing icons, lists, details, and more. 
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Quick access 
The second new feature added to Windows 10 File Explorer was Quick access.  

 Quick access replaced the Favorites section from earlier versions of Windows Explorer. 

 When File Explorer is opened, Quick access appears in the left navigation column, above 
Libraries, OneDrive and your storage devices. 

 You can add a file or folder to Quick Access by right-clicking it and selecting “Pin to Quick 
access”. To remove it, right-click and select “Unpin from Quick access”. This does not 
delete the folder from your computer, only the shortcut. Files and folders can be added and 
removed depending on your activity, making it easier to navigate and manage them. 

 Quick access is a collection of shortcuts to the files and folders you use frequently, making 
it simple to find them. It provides a convenient way to access frequently used folders and 
recently accessed files. 

 

Clover 

 With the introduction of Quick Access, Neil stopped using Libraries, preferring Quick 
Access for its simplicity and speed.  

 Around the time Windows 10 was released, tabbed file managers began to appear. Knowing 
that Quick Access was not a complete solution, Neil searched for a simple tabbed file 
manager. The answer came in October 2019 when Dave Botherway gave a presentation to 
East SIG and mentioned Clover. 

 Clover seemed to be the perfect solution for Neil, so he gave it a try and hasn't looked back 
since. 

 

Figure 32 - About Clover, version information 

What is Clover 

 Clover is not a file manager, but an add-on to the Windows File Explorer. It's very simple to 
use because it's not a new program, so there's virtually no learning curve. Clover doesn't 
remove any features from your current Windows File Explorer. Clover works with 
Windows XP, Windows 7, Windows 8 & Windows 10. 

Users should be aware that Clover replaces the File Explorer icon with a clover icon, but 
Clover is essentially File Explorer with added features. Don't search for File Explorer 
elsewhere on your computer, as you won't find it. 

 Clover adds 2 very useful features to Windows File Explorer.  

o Firstly, Clover adds browser-style tabs to File Explorer. These tabs enhance file 
organisation and multitasking by allowing users to open multiple folders or directories 
in separate tabs within a single file manager window. This means you can switch 
between different locations without cluttering your desktop with multiple open 
windows. 
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o Secondly, Clover adds a handy bookmark bar for your most frequently accessed files 
and folders. As Neil later demonstrated, his bookmark bar contained many of his Quick 
Access shortcuts. The bookmark bar is more convenient than Windows Quick Access 
links because it is located directly below the tabs, requiring minimal mouse movement. 
 
To create a new bookmark, simply hold and drag a file onto the bookmark bar. To 
remove a bookmark, right-click the bookmark and select delete. 

 Download Clover from http://en.ejie.me/  

 Disadvantage 

o The Clover website and software are available in English; however, the installer is in 
Japanese. English-speakers can easily follow along by clicking the green button and 
selecting the default options, as shown in Figure 33. 

o The latest version 3.5.4 has been flagged as containing PUPs (Potentially unwanted 
Programs) by VirusTotal. In his demonstration and screenshots included in this 
report, Neil is using version 3.0.386.0 without any issues.  

 

Figure 33 – Clover installation screens  

 Reviews. 
A 28th March 2024 article on the TechRadar website, titled "Best File Manager of 2024," 
reviewed Windows file managers. The article rated file managers based on the criteria that 
"The best file managers make it simple and easy to manage your data in Windows in a 
better way than the default File Explorer." The ratings in five distinct categories are listed 
below, with Clover one of the best: 

 Best file manager overall - Total Commander 
Best file manager for power users – Directory Opus. 
Best premium file manager, but with horizontal panels - Xplorer². 
Best file manager with multiple panes (4 panes are better than one) - Q-Dir  
Best addon alternative to a file manager – Clover 
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 The TechRadar article can be found at https://www.techradar.com/best/the-best-file-
manager. The section of the article detailing the best file manager addon is shown below in 
Figure 34. 

 

 

Figure 34 – TechRadar 2024 review 

 

Features 

Clover is very easy to use as it’s an add-on to Window File Explorer. Users familiar with File 
Explorer and tabs in web browsers will feel comfortable using Clover right from the start.  

 An Options menu, represented by a spanner icon at the top left of the Clover window, 
allows you to open a new tab or an easy way to open a new window for those wanting two-
panel operation.  
Further options are available under Settings, but the default settings are generally sufficient. 
Neil noted that he rarely used the Options menu after the initial installation. 

 To open a new tab  

o Click on the small folder shaped icon at the end of the tab bar.  
o Drag and drop the file onto the tab bar. (i.e. to drag, mouse click and hold) 
o Shortcut Ctrl  +  N  
o From the Options menu as outlined above 
o Tabs can be closed by clicking the x on the tab. 
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 To add shortcuts to the Bookmark bar 

o Drag and drop a file or folder onto the Bookmark bar.  
o To remove a bookmark, right click on it and select delete. This only deletes the 

bookmark and not the file.  
o Right click on the Bookmark bar for further options   

 

 

 

Figure 35 – Clover adds a Tab bar and Bookmark bar 

 

 

 

 

Figure 36 – Clover Option menu 
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 Tips 

o Adding your most used Quick Access items or a current project folder onto the 
Bookmark bar, is a quick way to open them when needed in a new tab with a short 
drag and drop to the Tab bar. This approach is a very quick and convenient way 
open a new tab in Clover.     

o To change the order of your tabs, drag a tab along the top of the Tab bar with your 
mouse. 

o To open a bookmark in the active tab (i.e. the tab that’s current in view) simply click 
the bookmark for it to appear in that tab.  

o One of Clover's strengths is that it makes copying or moving files between tabs easy, 
following the traditional Windows File Explorer actions.  

 To copy or move files from an open tab, highlight the files or folders you 
want to transfer.  

 Click and hold the right mouse button on the highlighted files, then drag 
them to the target folder's tab on the tab bar.  

 Keep holding the mouse button down until the new folder opens, then move 
the cursor into the files area and release the mouse button.  

 This action will open a small window where you can select Copy here or 
Move here, as shown in Figure 37.  

This technique for copying or moving files in Clover has eliminated Neil's need 
for a dual-panel file manager, although he has one installed, but rarely needs to 
use it. 

   

  

Figure 37 – Clover, Copy & Move menu 

 

Summary 

Clover simplifies file and folder management by using the familiarity of File Explorer. With its 
Tabbed interface and Bookmark bar, Clover has proven to be an excellent addition to Windows File 
Explorer. The combination of Quick Access and Clover enables Neil to work efficiently without the 
need for multiple instances of File Explorer open or a dual-panel file manager. 

 
 
Neil Muller 


